PowerPoint Pointers 

I. Introduction

A. Microsoft's PowerPoint®  is rapidly becoming the standard for presenting visual aids with oral presentations.

1. PowerPoint can allow the development of very powerful and effective visual aids.

2. PowerPoint can also allow the development of very poor visual aids that can detract from the presentation.  

B. The best advice for developing effective visual aids with PowerPoint is to start with a good presentation that is well organized and structured.  Add PowerPoint slides to support the various points in the presentation.  

C. This outline presents some key PowerPoint methods that can simplify the development of slides with PowerPoint.  This is not a basic learning PowerPoint tutorial.  Learning PowerPoint is best accomplished using one or more of the following methods:

1. Obtain one of the many PowerPoint self-instruction books that are available at any good computer bookstore—pick the one that fits your needs, budget, and learning style.  

2. Access one of the many PowerPoint tutorials that are on the Internet.  A large number of different universities and other schools have good Internet sites for getting basic PowerPoint instructions.  Many of these can be found by using any of the search sites and searching on "PowerPoint Tutorial." 

a) An excellent Internet site maintained by Auburn University Libraries has links to many useful PowerPoint tutorials.  http://www.lib.auburn.edu/madd/docs/powerpoint.html
b) PowerPoint tutorial maintained by the Department of Computer Science at the University of Rhode Island provides a good tutorial for developing visual aids in PowerPoint.  http://einstein.cs.uri.edu/tutorials/csc101/powerpoint/ppt.html 

c) Lynn Bacon's PowerPoint Internet system maintained by the New York University School of Education provides some good tutorial and other resources such a links to other useful Internet sites.  http://pages.nyu.edu/~lqb0313/getstart.htm 

d) The PowerPoint Guide Internet site maintained by the School of Library and Information Management at Emporia State University has a good beginning paper on the use of PowerPoint.  http://slim.emporia.edu/RESOURCE/ppoint/ppguide.htm 

e) The Introduction to Microsoft PowerPoint Version 4.0 Internet site maintained by the University of British Columbia faculty of Commerce and Business Administration has a good site for this earlier PowerPoint version.  http://www.commerce.ubc.ca/MBAcore/tutorials/powerpoint/pptintro.html 

f) The Land-Grant Training Alliance Online PowerPoint 97 Learning Microsoft PowerPoint 97 Internet site maintained by North Dakota State University Agriculture Communication also has a learning tutorial.  http://www.lgta.org/ppt97  

3. Use a commercial PowerPoint training courses.  Your employer may have some commercial PowerPoint training tapes and programs, which are useful.  The online training PowerPoint tutorials maintained by numerous universities may be a better starting point than buying a commercial training program.

4. The best way to learn is to use PowerPoint.  Try something new in each presentation.  Don't limit the presentation to simply text lists.  Support you points with graphics and text.  Use animation to present the text and graphics. After several presentations you will have a surprising command of the software's capabilities.

D. The section titled Developing and Using Visual Aids presents guidelines for the development and use of visual aids.  Using these guidelines will improve the quality and effectiveness of the PowerPoint slides.  

E. This outline presents some pointers that can enhance the use of Microsoft's PowerPoint to develop visual aids.  Points that can significantly help in the development of PowerPoint slides are presented in this outline.

1. Recommendations on how to configure PowerPoint

2. Understanding how PowerPoint copies objects

3. Understanding how PowerPoint layers objects

4. Use of PowerPoint slide transitions and animation

5. Use of digital images

6. Miscellaneous tips

II. PowerPoint configuration

A. Set options in the Tools menu to meet your personal preferences.  The following settings are recommended:

1. View tab

a) Turn off "Popup menu on right mouse click."

(1) This will prevent the accidental display of the popup menu during the presentation if the right mouse button is clicked.

(2) The right mouse button will move to the previous slide.

b) Turn off "Show popup menu button"—the popup menu button is not visible, resulting in a cleaner slide.

c) Turn on "End with blank slide."

2. General tab

a) Have PowerPoint show the last nine files—this can help find a lost file.  

b) Enter name and initials in the User Information box—provide the user information to file properties box.  

3. Edit tab

a) Turn on all options to simplify editing.  

b) Increase the number of undos to at least ten, and twenty is better.  

4. Print tab

a) Turn on "Background Printing" to allow printing while working on slides.  

b) Turn on "Print at printer resolution" to speed up printing.  

c) Set default printing format to six slides per page to save paper.  

d) Turn off "Print Hidden Slide" to print slide show correctly.  

e) Turn off "Black and White" for better printing results.  

f) Turn off "Pure Black and White."  

5. Save tab

a) Turn on "Allow Fast Save"—faster file saving but results in larger files.  

b) Turn on "Save autorecover info" for thirty minutes—use longer time periods for large file to save time.  

6. Spelling tab—Always set spell checker to "show all spelling errors."  You do not want a spelling error.

7. Advance tab—Set the default file location to a directory that is easy to find using Windows Explorer.  

B. Customize the PowerPoint toolbars to increase the ease and speed of developing slides.  

1. Use the PowerPoint toolbars to speed the development of the slides.  The standard toolbars that are most useful include

a) Standard

b) Formatting

c) Animation Effects

d) Common Task

e) Drawing

f) Picture

g) Word Art

2. Some additional tools should be added to the standard PowerPoint menu bars.  The tool buttons that should be added to the existing toolbars include

a) Lines

b) Freeform

c) Edit points

d) Superscript

e) Subscript

3. The use of two custom menu bars will greatly simplify and speed the development of PowerPoint slides.  The two recommended new custom toolbars include the following:  

a) Add a new toolbar for alignment of PowerPoint text and graphic objects.  The new custom alignment toolbar should have the following tools buttons:

(1) Align left

(2) Align center

(3) Align right

(4) Align top

(5) Align middle

(6) Align bottom

(7) Distribute horizontally

(8) Distribute vertically

b) Add a new toolbar for grouping and controlling the layer order of the PowerPoint text and graphical objects.  The new custom layer control toolbar should have the following tool buttons:

(1) Group

(2) Ungroup

(3) Regroup

(4) Bring to front

(5) Send to back

(6) Bring forward

(7) Send back

(8) Snap to grid

(9) Snap to shape

(10) Rotate Left

(11) Rotate Right

(12) Flip horizontal

(13) Flip vertical

4. All of the various toolbars can be placed or docked around the screen.  Docking the toolbars on the left and right side of the screen allows the most effective use of the screen area without reducing the size of the slide: 

a) Place or dock the toolbars above, left, right, and under the slide working area.  

b) Toolbars can be moved with the mouse by placing the cursor over the double bar end of the menu and holding the left button down while dragging the menu to a new location.

5. Procedure to modify menus

a) Select Customize from Tools menu.  

b) Select Toolbars in Customize properties box to turn on standard menus and any new custom toolbars.  

c) Select Toolbars in Customize properties box to create or rename existing menus.

d) Select Commands in the Customize properties box to add tools to an existing or new menu bar.

(1) Find and highlight the desired tools.

(2) Left click the mouse with the cursor over the tool and drag the tool from the Customize box to the desired toolbar.

III. Understanding how PowerPoint copies objects

A. Understanding how PowerPoint copies and pastes objects can ease the development of slides.

1. PowerPoint will paste a copy of a text or graphic object in the exact location on a blank slide as the object's position on the originating slide.

2. PowerPoint shifts a pasted object slightly to the right and down when pasting an object over another object of the same size and location.

3. PowerPoint will not shift the pasted object if the underlying object is a different size or shape.  

B. Use a blank slide for the temporary development of a new object.  Once the object is complete, use the copy and paste tools to add the revised object to the slide and delete the temporary slide.  

C. Example—How to highlight a box by changing its color during a presentation.

1. Use the "Rectangle" tool button to build the box.

2. Add the desired text and select the desired font and size.

3. Set the fill, line, and text color.

4. Select the box with the cursor.

5. Copy to the box to the clipboard.

6. If the "Paste" tool button is used now, the copy will be shifted to the right and down.  

7. To avoid the shifting

a) Add a second box of any shape and size—this box will be deleted later.

b) Use the "Group" tool button to group the original box and the new box.

c) Paste the box from the clipboard, which should be in the exact location of the original box.  

d) Place the cursor over the new box and click.  

e) Use the "Ungroup" tool button on the group of the two boxes.

f) Delete the new box.  

8. Change the color of the top box to the desired highlight color.

9. Use the Custom Animation tool to animate the top box.

a) Select the top box in the Timing tab of the Custom Animation properties box

b) Select Animate on Mouse Click.

c) Select the Effects tab.

d) Select Box Out.

e) Click OK and test animation by selecting the slide show icon at the lower left of the screen.

IV. Understanding how PowerPoint layers objects

A. PowerPoint stores each object in its own layer.

B. Each object or group of objects is saved as a layer.

C. Each object can be moved forward or backward with the tools provided with PowerPoint.

D. The object layer order is now independent of the animation order.

E. Boxes with the same fill and line color as the background can be used to mask part of the animation to make it appear as if an object is coming from one object to another.  

F. The animation of an object will occur on the same layer as the object—for example:

1. If the first object is in front of another or second object, then the animation effect, such as fly right and zoom, will occur in front of the second object.

2. If the first object is behind or in back of the second object, then the animation effect will occur behind the first object.  

V. Use of PowerPoint slide transitions and animation

A. Limit the use of slide transitions.  

1. Start with a blank slide.

2. Use custom animation to expose each object on a controlled basis.

3. Use slide transition only to change slides that do not use animation to expose each object.  

B. The use of PowerPoint's animation is one of the most powerful tools to create effective visual aids.

1. Animation can be used to progressively disclose information.  

a) To increase audience recall

b) To control audience focus

c) To add interest

2. Each object on a PowerPoint screen can be animated, except the objects and text placed on the master.

C. Controlling animation is best accomplished with the Custom Animation input box, which contains the "Animation order" box and has four tabs.

1. The order of animation is presented in the "Animation order" box.

a) The objects at the top of the list are animated first.

b) Selecting an object in this box allows the view of the animation timing and effects.  

2. Timing—Used to select an object from the "Slide objects without animation" box define the animation timing

a) Don't animate.

b) Animate on mouse click—A mouse click is used to start the animation effect.

c) Animate automatically with no time delay or zero seconds delay—The animation effect starts automatically after the last animation effect has finished.  

d) Animate automatically with a time delay set in whole second increments—The animation effect starts automatically after the specified time delay between the completion of the last animation effect and the start of the new animation effect.

3. Effects—Used to select the animation effects from a list, sound effects from a list, and the display after animation

a) Limit the number of different animation effects that are used in a slide and in the slide show.

(1) Preferred animation effects for graphical objects

(a) Animation effects that are used frequently

(i) Wipe series (wipe up, wipe right, wipe left, and wipe down)

(ii) Box in and box out

(iii) Dissolve

(iv) Zoom in slightly

(b) Animation effects used for special emphasis

(i) Spiral

(ii) Zoom in

(iii) Zoom in from screen center

(iv) Fly from various sides

(2) Preferred animation effects for text objects

(a) Animation effects that are used frequently

(i) Wipe right or wipe down

(ii) Fly from the bottom

(b) Animation effects used for special emphasis

(i) Spiral

(ii) Zoom in

(iii) Zoom in from screen center

(iv) Fly from various sides

4. Chart effects—Used to control the animation of a chart

5. Play settings—Used to control the start of video or another animated object

D. Some animation tips

1. Changing slides

a) Start with a blank slide.

b) Animate the title with the timing set to automatic with no time delay.

c) Use mouse click to animate the next object.

2. Using a series of different animation effects one after another to produce an animation sequence

a) The first animation is started with a mouse click.

b) The following animations are started automatically.

c) The first object that is not in the animation series is started with a mouse click.

3. Animation of text points and subpoints

a) Text in a text box with points and subpoints must be presented as one line after another until the entire text box is presented.

b) Select the text to be animated.

c) Must select the entire text box with all of the points and subpoints.

d) Select animate on mouse click.

e) Select the animation effect.

f) Check grouped by button and select the level of animation.

g) Select after animation drop-down menu.

(1) Select the color such as gray.

(2) The text will be displayed in the selected gray after the animation effect is completed.  

(3) Only the current text will be in the color selected in the slide development screen.  

4. Animation of both graphics and text

a) A text list and a series of objects can be animated to allow an object to be displayed following a line of text.  

b) The text to be displayed must be in its own text box.  

c) The text boxes can be positioned to look the same as if they were in a single text box.

E. Use custom animation to progressively expose objects.  

F. Use different animation effects with the timing set to automatic to produce a movie effect.  

G. The progressive disclosure of a complex diagram or graphic can extend across several slides.  

VI. Use of digital images

A. High-resolution digital images are only useful when displayed on high-resolution monitors or projectors.  

B. High-resolution digital images generate very large files and extremely large PowerPoint files and can slow the performance of PowerPoint.  

C. The image cropping tool in PowerPoint does not crop the image but adds a mask to restrict the displayed area.  The file size is not affected by PowerPoint's image cropping.

D. Use an image editing software such as Photo Shop®  to crop the digital image, which will reduce file size.

E. Use an image editing software such as Photo Shop to reduce the image size and resolution to match the screen projection resolution, which will significantly reduce the PowerPoint file size.

F. Use an image editing software to change the color in an image and paste the image into PowerPoint.  

G. PowerPoint can change the display area or size of an image.  

H. Images can be added with the animation effects; however, large images can cause the animation effects to be slow.  

VII.   Additional miscellaneous tips

A. Build charts with the PowerPoint drawing objects.

1. Procedure

a) Build chart background with the rectangle tool and add lines for the grid.

b) Change the color of the rectangle tool and lines.

c) Use the Group button to group the chart background and grids.

d) Use the Line button to access the various line tools or use the Freeform button to build the chart lines and polygons.  

e) Add text as needed for the axis title and scale.

f) Add notes as needed.

g) Use the slide title for the chart title.

h) Animate as needed to coincide with the oral presentation.

2. Advantages

a) The chart can be simplified to meet the needs of the presentation.

b) The chart elements can be animated to coincide with the oral presentation.

c) Text elements or notes can be added in the middle of the chart animation.

d) Important parts of the chart can be easily highlighted.

3. Disadvantages

a) Longer time to develop.

b) The chart may not accurately present data that has changed since the original chart was developed.

B. Build tables with the PowerPoint text and drawing objects.

1. Procedure

a) Use a separate text box for each cell in the table.

(1) Use the various alignment tools to align the text in the columns and rows.

(2) Use the group tools to group the text for alignment and presentation.

(3) Size the text fonts for easy reading.

(a) Remember the minimum text font should be eighteen points.

(b) The text font will limit the amount of material that can be presented in the table.

b) Use the rectangle tool for the table background.

(1) Consider using a different colored rectangle for the columns' background if the table presents a comparison between columns.

(2) Consider using a different colored rectangle for the rows' background if the table presents a comparison between rows.

(3) Add lines for emphasis.  

c) Use animation to present the rows and/or columns to coincide with the presentation.

2. Advantage

a) The table is easier to read.

b) The table can be animated to coincide with the presentation.

c) The table must be simplified to fit into the slide while using the minimum text font size of eighteen points.

3. Disadvantages

a) The table may take longer to develop.

b) The table may not accurately present data that has changed since the original table was developed.

C. Build a library of different slide shows that can be copied into other slide shows.

1. Use only one or two slide show templates with a consistent color scheme—this simplifies the coping of slides from one slide show into another slide show.

2. Build of library of preformatted charts, tables, and other slides that can be simply and quickly modified for use in other presentations.

3. Maintain the library of past slide shows in a easily accessed directory.

a) Use old slide shows for ideas.

b) Use parts of old slide shows for material in new slide shows and presentations.

4. Use the first slide to present the slide show title, date, version, and other key information.  

a) The title slide can be previewed and used to select the slide show to be opened.  

b) The first slide is not normally presented in the slide show and can be hidden.  

c) The file properties information can do the same thing—always complete the information in the file properties box.  

D. Frequently save your work.  

1. Save your work frequently—don't rely on the PowerPoint backup procedure.  

2. It is a good idea to save work periodically under a new name to avoid losing work should the PowerPoint file become damaged, which does occur infrequently.

3. Consider using one PowerPoint file for development of the various presentation elements and another file for the actual PowerPoint slide show.  

a) Use development file to build slides and once the slides are completed, copy into the final presentation.  

b) The use of a separate development file will limit the loss of material should a fatal error occur.
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